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Your Guide to Supplying
Print-Ready PDF Files

File Requirements

« Save your images in CMYK mode at 300dpi;

«  Supply cover as a spread inc. spine as a PDF,;

« Supply text as single pages in one PDF;

« Include 3mm of bleed to your cover and text artwork;
- Embed all fonts;

-  Save your file with ‘PDF/X-1a:2007 settings.

© 2019
Printed and bound in Great Britain
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Introduction

File preparation for press is not often thought about in great depth by those outside the trade, until
the last moment when the project finally comes to be printed. Suddenly, a whole host of technical
jargon and requirements are thrust upon you, when you have the least amount of time to spare
before that inevitable book launch.

Hence the aim of this guide — to teach you a few technical requirements and aid you in preparing
print-ready PDF files that will mean your book is produced just how you want it.

Service expectations

Files supplied to us are checked (“pre-flighted”) when they arrive at our pre-press department for the
technical requirements of commercial printing, and “Fit For Purpose” checked against the job brief —
i.e. does the artwork match the order’s size, and are the cover dimensions correct for the expected
size of book? etc. It should be noted that files supplied to us are expected to have already been
proof-read — we do not check for spelling and grammar.

What is a PDF and why use it?

The most reliable and accurate method to transfer files between your system, through pre-press
and imposition schemes and then on to the press is to use a portable file format — the industry
standard PDF.

PDF (Portable Document Format) “locks” the words and images in place on the page and when set
up correctly ensures that everything needed for printing is contained (or embedded) within the one
file, so regardless of computer platform or printing press, the end printed result is the same.

This is unlike supplying a Word file, for example — Word files do not transfer well between systems,
as they rely on the individual computer’s fonts and printer settings, which vary from computer to
computer.

PDFs can be made from any program, because it is based on printer code. Imagine sending a
document to your desktop printer — the data that goes down the cable to the printer gets captured
to a file that can then be released to another printer miles away — that’s the essence of PDF.

In fact one method of creating a PDF is to print a document to a “PDF printer”, which actually saves
a file to disk instead of sending the data to a printer. Nowadays programs can simply “save as PDF”,
but the internal process is the same.
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There are many page layout and desktop publishing programs that can create a PDF.

InDesign (and previously, QuarkXpress) is the industry standard page layout programs, if you are
serious about designing lots of titles, this would be well worth the investment in money and the
time to learn the complexities of it. With InDesign you can get very professional effects and results
that mainstream publishers’ produce. Other programs are also available, that may produce results
suitable for your project with less of a price tag.

Any program that can print to printer can be used to create a PDF. If you can’t save-as or export
to PDF, you can always print to PDF by using a PDF printer — remember that’s a virtual printer that
saves the file to PDF. Free ones like Nitro and CutePDF are available online, while Adobe Acrobat
Professional is the industry-standard PDF creating and reading program.

As long as the resulting PDF meets the specifications outlined in this booklet, the program used is
less important.
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There is a variety of book styles that can be produced, each having different components that each
require a separate PDF from which to print.

Saddle-stitched booklets

have a set of inner pages and often an outer (thicker)
cover, folded in half with two staples in the spine to
keep it all together. The folded booklet is then trimmed
flush to the specified size.
Components: Cover, Text

Paperback (limp) books
have a “book block” and a card cover — usually
printed in colour and glued to the spine (“bound”), then
trimmed flush to the specified size.
Components: Cover, Text.

Hardback (cased) books

have the book block bound on the spine with front
and back endpapers (which can be coloured black or
white), and trimmed to the specified size.

This trimmed book — block is then “cased-in” — the
hard cover (or “case”) is glued to the front and back
endpapers (not the spine) and overhangs the book
block by about 3mm. The case can be either finished
in cloth or a printed paper case (“PPC”).

A cloth cover can have a “foil blocking” applied
(Lettering or simple graphics stamp embossed, usually
in gold or silver).

A dust-jacket can also be wrapped around the finished
book.
Components: Text, Endpapers, PPC, Jacket, Foiling

Spiral/Wiro books

Cover and book block is printed and trimmed to
the specified size. Once they are trimmed, they are
punched with the relevant holes. They then have
the spiral/wiro inserted and is crimped or fastened
depending on which style.
Components : Cover, Text



Bleed printondemand

© © © © ©-WORLDWIDE.COM

Bleed is a fundamental requirement of printing yet is often overlooked as it is not obvious to the
end reader that it is required.

Bleed is artwork that extends beyond the desired size of the book, this is so that when the book is
trimmed to the final size there are no white strips left at the edge of the book. This is to account for
slight movement in the print and finishing machinery. The industry standard is 3mm and is what we
require for our files.

For example, a book that was A5 (210mm x 148mm) would need artwork supplied as 216mm x
154mm; that is if you require the print to go to the very edge of the page.

33

The image on the above artwork is set 3mm beyond the finished page size (i.e. it bleeds correctly).
Therefore, the image, once printed and trimmed to final size, always goes to the edge of the page,
even when there is slight movement.

The image on the above artwork doesn’t have any bleed; if the position is slightly affected by print
and binding, it will result in white showing at the sides of the pages once trimmed to the final size.

NOTE: If you have any images that you want to be printed up to the very edge of the page, make
sure you supply a minimum of 3mm bleed on artwork.
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Here’s a collection of images at different dpi (dots per inch) settings for you to evaluate their quality.

An image’s dpi can be found using Photoshop: File > File Info or use shortcut: Alt + Shft + Ctrl + |

Remember that by enlarging or reducing the
image, its dpi is also affected. For example,
a 200dpi image doubled in size will be
reduced to 100dpi.

Note: Make sure any images you have in your book are 300dpi to ensure good quality production.
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Because printing processes use CMYK (cyan, magenta, yellow, black) inks, digital art must be
converted from the RGB (Red, Green, Blue) colour for displaying on a monitor to CMYK colour for
print, at some point in the design/print process.

RGB CMYK

If your page layout software is capable of CMYK workflow, use CMYK based colours, and convert
source images to CMYK (e.g. using Photoshop) before placing into your page layout program. For
best colour conversion use a FOGRA colour profile if available.

Where this is not possible, we can accept RGB images, but please note that RGB will be converted
to CMYK on the press, and the colour conversion may not be as good as the method described
above. Most digital devices (such as digital cameras) tag the RGB image with a source colour
profile, which makes the RGB conversion more accurate.

Spot Colours

Digital printing only uses the CMYK primaries,
so any spot colours used are converted on the
press to CMYK. However, using spot colours on
a digital product can be a more accurate way of
colour matching — Pantone to CMYK conversion
will be a closer match than trying to match a
colour on an RGB monitor screen.

Note : Images may look different on your RGB computer monitor compared to when coming out in
CMYK print. Save your images as CMYK format if possible.
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Before generating a PDF file for the text element of your book, here are some tips to make the
book look more professional and reduce the likelihood of experiencing problems during the print
process:

® Ensure the document page size matches the size of the book. The only exception to this is if
your document requires bleed and the program you are using doesn’t support it, e.g. MS Word —
in this instance the document page size should be set to 6mm bigger than required (remembering
that 3mm will be trimmed off each edge). For example, a book that was A5 (210mm x 148mm)
would need artwork supplied as 216mm x 154mm if bleed is required.

®* Make use of the text justification settings — e.g. centre headings (don’t keep pressing space
until it looks centred!), while fully justified aligns the text to both left and right margins;

® Use tabulation (or the Tab key) on contents, indexes and tables to keep lists in line;

® Use page numbering. It’s conventional not to have a page number on the title pages, and use
roman numerals for the preliminary pages, starting the first chapter as page one on a right-hand
(facing) page.

® Use good quality images (300dpi is optimum, anything below 150dpi will start to look pixelated
in print) — remember that an image scaled up to twice the size will half its resolution.

® Ensure that all fonts used in the document are available to your computer (otherwise the font
will not embed into the PDF)

Most modern programs can save or export to PDF. Below are the generic settings to employ on
professional-grade software:

Composite Output (e.g. all colours on one page, not separated)

Fonts: All embedded or subset

Bleed: 3mm

Trim marks: on, offset: 5mm

Include blank pages

Do not enable reader’s spreads

Image compression: Colour & Greyscale: 300dpi, mono/bitmap: 1200dpi.

If available, using “PDF/a” standard will ensure fonts are embedded.
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To be able to create a print ready PDF in Word 2007 you will need to check whether you have the add
on to do this already installed on your PC.

To check go to the Office J E button in Word 2007 (top left hand corner) and click on it so that it drops
down. Hover your mouse over the Save As options.
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If you don’t see PDF listed as one of the options then you will need to download and install the
Microsoft Save as PDF add on from the Microsoft website.

Open the document that you want to save as a PDF and then go the Office button and click on it so that
it drops down. Choose Save as type PDF.
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Before you press the Publish button check that Standard is selected in Optimise for and then click

on the Options button.
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When the Options window pops up make sure that you tick ISO 19005-1 compliant (PDF/A) under PDF
options. It is essential that this is selected otherwise the fonts will not be embedded in the PDF and

it will not be print ready.
—
[l ]
ey e————r— [0 )| Sawn 3 w
- ! e T e
e —— ] w-:l;\aﬂl]un{ AdbCo ABECA KalibCr | EA i
- - Vownangt [towatng 1]t owntmp ol ¢l Fim g | g 1 | R
T
B . s e taaes
| W Ly o f ke
B v --
B e Fageal
W e R EAEP i st Whes pius (onastes e il of bocda
- # i ot least, on o brved with e computiln,
E: " ~
B il vrvig blovuton F Prenariation of yins worh i 100N pellteg s tima
B [RETLTR EETERTR Y r,f Miyle e preeriation of o book lgpoty P
e /
. - s -
N r 4 Bon ol brmaston e aond ¥ oter et ot flory b bty
Fin gy Mol | D vt - T P eresertational loks for your took e the eme
Tmew by R | PP e o [he rurbee of pages. Thin rensarch B0 B aaaldil
- B R | ot POE 8 e
- - - . — S
[ 5 ot For. v to orwet:
i nout For. e o
Dy
b e | i v B |
= by Py L P Lacm
[enkche sl |

# Bamefleng lr i by
W Tl of papar; gusiey of the pow brard
& Bpbed prices e bhe b of page

Loms of thews spacts =L mataally, b Jovemaed By pous o g ol Han or the dlen
o bl il W el i, Fiiviried, Wi el Ll il B 1 e e Eainin b S i
ikl B v ) e e Bl BG The Wle oF TRatRT Ekiae 10 e il #asbEr
g shae & peloegs



Creating PDF from Microsoft Word griglggugmggg
2008 for Mac
It is very easy to create print ready PDFs for text only books using Mac Word 2008.

When you are ready to create your PDF then simply go to File / Save As... and choose
PDF from the drop down list to the right of the Format box.

Save As: Creating print ready PDFs from Mac We rZ1

[« || l2a|=m| |EE Applications 4| (Q search 1
@h Al | Address Book ’1
L Adobe /
¥ PLACES +] Adobe Acrobat 9 Pro
B Desktop Ell Adobe Bridge CS4 |
@ nickypre... || [ Adobe De...entral C54 -«
ﬁ\-ﬂ«s.'v-:ﬁ-:-v—-_' | 7= Adobe Drive C54 Y
7 Documents | Adnhe Fy  naner 0S4 - !
50 il e !

Format: | PDF

"

Description

Exports the document to a PDF file, which looks the same on Macintosh and Windows computers.

_ New Folder "- Cancel -\ 'f Save \

e

P

And that is all there is to it!

Once you have created the PDF then do a quick check just to make sure that fonts are
all embedded. Open the PDF file and go to File / Properties and then the Fonts tab and
make sure the words (Embedded Subset) are to the right of the font names.

Document Properties

Description Security Fonts Initial View Custom Advanced |

Fonts Used in this Document

i v EiArial—BUldW {Embedded Subset)

Type: TrueType
Encoding: Roman

v || ArialMT (Embedded Subset)
Type: TrueType
Encoding: Roman

v [#|Cambria (Embedded Subset)
Type: TrueType
Encoding: Built-in

Help ) (. Cance!) ok )
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Creating PDF from Microsoft Word g[,iglgggvgg}uggg
2010

Creating print ready PDF files in Word 2010 is very straightforward.

When you are ready to make your Word document into a print ready PDF then go to File then Save As
and let Save as type drop down and then choose PDF.

i

(W] Save As | crosoft Word o & =
Q-\:) ‘ 5 » Libraries » Docdments » - |+,|| Search Documents o = =@
ELE A A = Al [ signature Line ~
Organize Mew folder = @ J j Q ﬁ J A h"l 53 Date & Time Tc Q
rence  Header Footer Page Text Quick WordArt N Equation Symbaol
Templates “  Doduments Hbrary ) ) - ~ Mumber- | Boxr Pasr v 9 Object ~ 5 -
Arrange by:  Folder ¥ Header & Footer Text Symbols
Inclufles: 2 locations —]
¢ Favorites - iy
Pl Desktop Ham, Date medified Type & =
% Downloads 3 i Music File folde|
1 Recent Places 5 Pictures folde|
B Ny Videos File folde'
i Libraries Qhtlook Fil File fold : 2
"5 = R 1199 ftems that are designedto
| Documents L 207605 Adobe A¢
o Music i . 5 adopen - firdocument. You can use these J
= Pichres ! it 5 ters, lists, coverpages, and other
File name: Or\thelnsev ~ |create pictures, charts, or
Save as type: | PDF ~| |ourcurrentdocumentlook.
Authors: Nicky Prentis Tags: Add atag ofselectad textinthe dostrart
Optimize for; @ Standard (publishing r— ed textfrom the Quick Styles gallery
ShinC s g PDDM TS ttext directly by using the other
e I ) lols offer a choice of using the look
h. N matthat you specify directly.
= Hide Folders Teels + | Save Cancel
) cument, choose new Theme
elements on the Page Layoutfab. To change the looks available inthe
Quick Style gallery, usethe Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide resst
commands sothat you can always restore the look of your documentto
the original contained in your currenttemplate.
-
On the Inserttab, the galleries include iterns that are designed to N
coordinate with the overalllook of your document. You can use these *
Page:lofl | Words: 238 | < | 1 \Ei HEE = 100% (=} £} +)

Before you click Save click on the button that says Options and tick ISO 19005-1 compliant (PDF/A)
under PDF options. It is essential that this is selected otherwise the fonts will not be embedded in
the PDF and it will not be print ready.

h
W] Save As = # = g
2 ) e e . - @
) [ » Libraries » Documents » BENE i ’ R
- — B 5 | i j 4 ! | Signature Line ~ T[ Q
Organize v New folder | Options 1 - o J | 2 2] - ! (53 Date & Time
rence  Header Footer Text Quick Wordart Equation Symbal
Templates il |Fegeronge - - Do Paim Fgd Object ~ & =
@ Al Amange by:  Foldér = eader & t Text Symbols
s *) Current page =
¢ Favorites i - " =]
B Desktop A Page(s) From: 1 =
8 Downloads |
] Recent Places Publish what
© Document

4 Libraries

= Documents o n. s Eitemsthatare designpdto

Tindier: c i using — sdobe o = ardocument. Youcan Jsethese
s [ 8 ters, lists, cover pages and other

it propesie ~ |create pictures, chartsjor

Save astype: [PDF | @Dommentswucwﬁwmﬂ#w -] lourcurrentdocumentipok.

Authors: Nicky Pr

Indude non-printing informatien

=l Pictures

File name:  Onthe 5

of selected textin the document
ed text from the Quick Styles gallery
ttext directly by using the other

Optimize for. @ § pns..

- er publishing ; .
1 J ols offera choice of using the look
matthat you specify directly.
“ ' Hide Folders Tools = Save ‘ Cancel ‘

cument, choosenew Theme
elements onthe Page Layouttab. To change the looks available in the
Quick Style gallery, use the Change Current Quick Style Setcommand.
Both the Themes gallery and the Quick Styles gallery provide reset
commands sothat you can always restore the look of your documentto
the original contained in your currenttemplate.

On the Inserttab, the galleries include items that are designed to

coordinate with the overalllook of your document. You can use these
Page:1of1 | Words: 238 | |[Elg =

Hlaowdq
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Creating PDF from QuarkXpress

Qutput Styles

show: | All Qutput Styles

Default PDF Output Style

Default Print Output Style

PDF/X-1a:2001

PDF/X-3:2002 |
|_Press - High Quality/High Resolution ¢
Print - Medium Quality/Medium Resoluticn

Screen - Low Quality /Low Resolution

Screen - Medium Quality/Low Resolution ¥

i

Style Name: Prass - High Quality fHigh Resolution
Output Media: PDF

[Edit PDF Style

printondemand
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From Edit menu, output styles,
duplicate [Press Quality] as a
basis and check the following

settings...

PDF Style: an’_ss - High Quality/High Resolution copy

Verification: | None

Page Options

Ensure "Spreads" is OFF "include

Pages

Meta Data
Hyperlinks
Compression
Color ™ Include Blank Pages
Fonts

["] Spreads
"] Export pages as separate PDFs

Marks [} Embed Thumbnail | Color Thumbnail

Bleed
Transparency
OPl

IDF

Summary

blank
pages" option ON

Edit PDF Style

PDF Style: |Press - High Quality /High Resolution copy

Verification: | None 4
Pages Color Options
Meta Data Mode: | Composite 4 Set colour
Hyperlinks
Compresion setup: [Asis conversion to none
Fonts
Marks
Bleed o
Transparency E_F!Il. PDF St_ylle
OFl
IDF
Summary PDF Style:  Press - High Quality/High Resalution copy
werification: | None H
Pages Registration Marks Options
Meta Data Mode: | Centered 4]
Hyperlinks e
Compression width: [0.088 mm
Color
Fonts Length: |4.939
Marks L) L
Bleed Offset: 3.175 mm
Transparency
oP
IDF 1 Include Bleed Marks
Summary
Edit PDF Style
PDF Style: | Press - High Quality/High Resolution copy
: f Verification: | None :
Registration marks, **
Bleed Options
Pages
3mm offset
4 Meta Data Bleed Type: | Symmetric ‘--:3
Hyperlinks 3
Compression Amount: {3.175 mm 3.175 mm
Color
Fonts Bottom: 3.175 mm 3.175 mm
Marks
Bleed M ciip at Bleed Edge
Transparency
i orl
3mm Symetric o
Bl.eed Summary
" "
Save PDF Style as "Books" to
use later without having to change e
the settings again!

Now to save your document as a PDF, File menu — Export — Layout as PDF, and
choose your “Books” PDF style in the PDF style dropdown.
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Creating PDF from Microsoft Word 2019

Creating print-ready PDF files in Word 2019 is very straightforward.

When you are ready to make your Word document into a print-ready PDF go to File then Save As and let

Save as type drop down and then choose PDF.

4 || « Copytech Data (\POD-QNAPT) (T:) > 2019 CustomerFiles » Fastprint Publishing > 01- Work In progress 2019 » Brigstock, Phillip «|® | Sesrch Brigstock Philip 5
Organize = New felder N AaBbCeD( AaBbCcD: AaBhCEDC AaBbCED(

I Desktop A MNome Date modified Type Size Emphssis  Intense B Strang Quote

Documents artwork File folder

) fytes
& Downloads oLp File folder
SIS A e
D Music Working files File folder
] Pictures 5 0781784566500-c Adabe Acrobat D...
B videos T o7e1784566500-t Adobe Acrobat D...
. Windows (€1 X Dino Days Cover File APPROVED Adobe Acrobat D...
I Dino Days Cover File APPROVED_Codes Adabe Acrobat D
= POD Workflow ([\POD-ONAPS) (1)
= POD Workflow? (\POD-QNAPS) ()
= imposed (\\pod-gnaps) (K) v
File name: -
Save as type: |PDF v

Authors:  Jennifer Brooks

Optimize for: @ Standard (publishing

onlin and printing)

QO Minimum size
(publishing online)

~ Hide Folders

Tags: Add a tag

Options...
[ Gpen file after publishing

Title: Add a title Subject:  Specify the subject

Tools = Cancel

Before you click Save click on the button that says Options and tick compliant (PDF/A) under PDF options. It
is essential that this is selected otherwise the fonts will not be embedded in the PDF and it will not be print-

ready.
a

+ « Copytech Data (\\POD-QNAPT) (T:) » 2019 CustomerFiles > Fastprint P

Organise ¥ New folder
¥ Downloads @
D Music
=] Pictures
8 videos
Windows (C:)

POD Workflow (\POD-QNAPE) (1)
POD Workflow? ({\POD-QNAPS) ()]

=

imposed (\\pod-qnap8) (K:)
POD Job Management (\\POD-QNAPT)
Copytech Data (WPOD-QNAPT) (T v

HHH

]

Name

artwork
oLp
Working files
T 9781784566500-¢
T 9781784566500t
FH Dino Days Cover File APPROVED
TH Dino Days Cover File APPROVED_Codes

Dino Days reveals the realities of classic car ownership and it focuses
on an icon of the classic car world, the Ferrari Dino.

Dino Days tells the exploits of Phill Brigstock and those of his family
over the past 50 years, having owned around 200 Classic Cars
between them. Watch out for James Bond, a Lamborghini Miura
related to the Italian Job film and an exploding Lotus.

Dino Days also tells the story of Enzo Ferraris true love, his first born
son, Dino and the beautiful and iconic cars that carry that name.

This book is aimed at the casual reader who has cast an envious and enquiring glance when a classic
car passes by.

Dina Days brings the reality of Classic car ownership to life,
culminating in a road trip to Maranello in Italy, the home of Ferrari,
whilst meeting several Dino owners along the way.

Phill is also a member of the Sporting Bears - a driving charity which
has raised aver £2.3 million for Childrens causes, by giving the public
“Nraam Rides” in intarasting cars at avents across the LIK in exchanoe

~ I

blishing > 01- Work In progress -2019 » Brigstocl

Phillip

v| &/ | Search Brigstock Phillip £

File name: | Bic codes and blurb

Save astype: PDF

Authors: Jennifer Brooks

Optimize for: @ Standard (publishing
online and printing)

O Minimum size
(publishing online)

A Hide Folders

Tags: Addatag

Options...
[ Open file after publishing

Options 7 X

Page range
@ an
() Current page
Selection
O page(s)
Publish what
(®) Document.
Document showing markup

Emphasis  IntenssE..  Strong Quote

yles
|
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Document properties
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PDF options hd
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[] Optimize for image quality

Bitmap text when fonts may not be embedded
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Encrypt the document with a password
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Dino Days reveals the realities of classic car ownership and it focuses
on an icon of the classic car world, the Ferrari Dina.

Dino Days tells the exploits of Phill Brigstock and those of his family
over the past 50 years, having owned around 200 Classic Cars
between them. Watch out for James Bond, a Lamborghini Miura
related to the Italian Job film and an exploding Lotus.

Dina Days also tells the stary of Enzo Ferraris true love, his first born
son, Dine and the beautiful and iconic cars that carry that name.

This book is aimed at the casual reader who has cast an envious and enquiring glance when a classic
car passes by,

Dina Days brings the reality of Classic car ownership to life,
culminating in a road trip to Maranello in Italy, the home of Ferrari,

13

printondemand

© © © © © -WORLDWIDE.COM

L] | AaBbCcDi AcBbCcD: AaBbCeDe AaBbCcDc AaBbCcDe A



Checking the created PDF printondemand
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After outputting to PDF, open the PDF in Acrobat Reader and perform the following checks:

* All pages have output.

* Textand images generally appear as they should print.

* Pages appear in the order they should print: to help you visualise as a book, use facing pages (with cover
page) in the View/Page Layout menu.

* Fonts are embedded:

To check that the fonts are embedded then open your PDF in Acrobat Reader and choose File
and Properties

W |J9-0|= Documentl - Microsoft Word = &#@ =
@
H =L On the Insert tab.pef - Adobe Reader = =
pture Line ~
wil WEEH Edit  View ndow Help x ” s 2

— & Time

cov| | % Open... Ctrl+0 \ -. | . Equation Symbal
i | =) (= | 103% =l B 2 | & Tools | Sign | Comment ||;. et

| T CreatePDF Online. Symbols
— nd has been epened read-enly te prevent medification.
Save As 3

[ &1

(2 Share Files Using $8ndNow Online... ~

Attach to Email...

o Click on Sign to add text
L

and place signature on a

[ Get Documents Sighed... PDF File.

Ctrl+W

m

Close

_ Properties... V D galleries include items that are designed to

& Pt crf verall look of your document. You can use these
SELT e es, headers, footers, lists, cover pages, and other
2\\MPG-BOD-RDS02\gS\MPG-Biddles\.. \85981 pdf 5
3 C\Users\nprentis\AppData\...\Biddles.pdf scks. When you create pictures, charts, or
4 CAUsers\nprentis\..\BADGES copy.pdf oordinate with your current document look.
5\\MPG-BOD-RDS02\...\YearboekPPCHardback.pdf L)
Exit ai-q € the formatting of selected text in the document

text by choosing a look for the selected text from the Quick Styles gallery
on the Home tab. You can also format text directly by using the other
controls on the Home tab. Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme
elements on the Page Layout tab. To change the looks available in the
Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset

La

Pageitoft | Wordsi238 | B | N [Elug z = 100 o) W

,
OlEmE

Then choose the Fonts tab: you should see embedded or embedded subset in brackets beside each font.

w96 Documentl - Microsoft Word = = R
= ——— > @
TTQOnthelnserttah‘pdf-AdobEREader \ [E= =]
0 - ~ _ ptureline -
E i [oorumentpropenes SN = o puetnes I Q
= : Time
e = S —— -
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Type: TrueType ~ = -
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Encoding: Ansi
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Creating cover layouts
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“Don’t judge a book by its cover” — yet a well-designed cover of a book can be crucial to its
success. Therefore, it may be well worth considering getting a professional designer to do the

work for you. If you do decide to prepare the artwork yourself, read on.

The outer cover, be it a paperback, hardback jacket, or printed paper case, is printed separately
from the text block, and is joined to it at binding stage. The cover and text are printed on different
machines and at different stages so need sending in separate files.

Imagine opening the book and turn it cover face up. You will see the back cover on the left, spine
in the middle and front cover on the right. That’s how the cover PDF file should look that you

supply for us to print

The following pages walk you through examples of each of the flatplans and the design

requirements for a professional looking finish.

If you're using a professional desktop publishing program to design your cover (such as InDesign),
you should set the document size to the size of the cover as indicated on the flatplan, excluding
bleed — as the bleed will be allowed for on output. Remember, though, to extend any bleeding
objects beyond the pasteboard by at least 3mm. The program can automatically add trim marks

when output to PDF.

If you’re using a program that doesn’t allow for bleed on PDF output (such as Word or Photoshop),
set the document size to the overall size of the cover as indicated on the flatplan including bleed.
Remember that 3mm will be trimmed off each edge, so keep any objects that shouldn’t bleed well

away from the edges.

Set guides (if available) to key points of the artwork (such as the spine — as indicated on the flat-

plans) to aid getting the right dimensions while assembling the artwork.

Back Cover

Front Cover
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Paperback cover artwork: printondemand
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328.8
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240 234 o 156
Back 16.8 Front
\
334.8

In this example, the trim page size of the book is 156mm width by 234mm height. The spine width
is 16.8mm, therefore the visible width (“excluding bleed”) =156 + 156 + 16.8 = 328.8mm

With 3mm bleed either side, the overall width of the artwork (“including bleed”) is then = 334.8mm

The visible height (“excluding bleed”) = 234mm. With 3mm bleed top and bottom, the overall
height of the artwork (“including bleed”) is then = 240mm.

NOTE that because paper is a natural product, and is affected by atmospheric conditions, the
actual spine bulk can vary slightly. A good design will take this into consideration by, for example,
not having a spine a different colour to the front and back, but to take the design around at least
one side of the spine. That way, any fluctuation in spine width goes unnoticed on the final bound
book. Such as the example below — the spine background extends to the back and front of the
cover.

Also notice the trim marks
identifying the final trim size, and
that the backgrounds and images
extend beyond the trim marks for
the bleed. All the readable text

is a good distance from the edge
so that it’s not in danger of being
Exploring the ‘Feminisation of Poverty’ trimmed off in production. Marks
in Africa, Asia and Latin America have also been added showing

: the spine width. This allows us to
=L d‘f.! G

[
(1]
=
(=N
1]
2
(n]
(1]
=
2
g
o
— ]
o
=
2
=
g
3
(]

double-check the artwork against
the specification.
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Paperback covers can also be printed on the inside of the cover — remember though that the book
needs to be bound to the inside of the cover, so a white area with no print needs to be allowed for
in the spine and 4mm either side of it for the “side-glue” (a bead of glue that is run up the inside
and holds the cover closed onto the book block). In our example of a book with 16.8mm spine, the
total white area width is then 16.8 + 4 + 4 = 24.8mm

A Question of Taste
KEITH SALMON

Size: (205 x140)
ISBN: 9781848974111
PRICE: £8.99/€10.99
CAT: POLITICAL/LEGALTHRILLER
FORMAT: PAPERBACK
RIGHTS: OLYMPIA PUBLISHERS
TERRITORY: ‘WORLDWIDE
IMPRINT: OLYMPIA PUBLISHERS

ABOUT THEBOOK

The UK Government faces a dilemma. BSE and CJD have resulted in every European
Union member state banning each other's produce. It comes up with the brilliant idea of
Millennium Meat which is aslurry of bugs, slugs and insects which it moulds and flavours
into substitute meat products. So successful is the project's appeal to the EU that the UK
uses itas ameans of balancing the nation's pension deficit and thereby avoiding projected
state bankruptey in 2075.

How it does this is a closel; rded secret until someone leaks it to the Ti

where Gavin Henderson runs a series of front-page articles. He has to be stopped —

permanently. It looks like the Government will achieve its objectives but, at the eleventh

hour, some ve andgood
taste.

Thebook taks ofcentral go

thepress, d d, lastly, some of the mostclosely-

guarded aspects of freemasonry.

ABOUT THE AUTHOR

Keith initially studied Pharmacy, then trained as a creative flavourist with Unilever. He
then entered IT as a programmer and worked his way up to Chief Executive in the City
of London. He worked in litigation support for twenty years on both sides of the Atlantic.
As a freelance consultant, he was an advisor on procurement, modernisation and
efficiency to many UK government departments. He lives in the Scottish borders with
his wife.

Olympia Publishers
Tel: 0207 618 6424 Fax: 0207 002 110

E-mail: pressrelease@olympiapublishers.com
www.olympiapublishers.com
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Dust jacket artwork:
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In this example, the trim page size of the book is 156mm width
by 234mm height. On a case bound book, the case overhangs
the internal pages by 3mm top, bottom and fore edge,
therefore the dust jacket’s visible height (“excluding bleed”)
should be 234mm + 3mm overhang top + 3mm overhang
bottom = 240mm. With 3mm bleed top and bottom, the overall
height of the artwork (“including bleed”) is then 246mm.

The “width of board” on the flatplan also includes an extra
millimetre to allow for the thickness of the board, before the
artwork of the flaps start, however, any background can be extended beyond this by 3mm if it'’s to

be seen when the book is closed.

Remember that the case boards overhang the text by 3mm, therefore the front width is 156 + 3 +
1=160mm. So that no text is visible on the flap when the book is closed, an 8mm non-text area is
recommended between flap and front/back. Flaps can vary in size, but should be in proportion to

the book, between 60mm and 100mm

Again, the spine width may vary slightly (see previous page), so a good design will take this into
consideration both at the spine and between front/back and flaps, such as the example below:

Oxford, Cambridge, and
n  Combridgeshire,

BARRY SHURLOCK lives in Winchester
the

£25

SCHOLARLY SOURCES,

21 Marston Gate,
WINCHESTER, S023 7DS. Tel:
+44(0)1962 861913

RRP:

yoopnys Avred

18

The Speaker’s Chaplain
& The Master’s Daughter

A GEORGIAN FAMILY & FRIENDS

to Wales
United States.

Barry Shurlock

CONTINUED ON BACK FLAP.
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The Speaker’s Chaplain & The Master’s Daughter
A GEORGIAN FAMILY & FRIENDS
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Turn-in
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On a PPC book, the cover is printed on paper and then wrapped around and glued to hard

board to make a “case”. The case is then glued (“cased-in”) to the book block by it's endpapers.
Remember that the case overhangs the book block by 3mm top, bottom and fore edge, hence the
visible height will be 6mm bigger than the trim-size of the book.

Any background should extend into the 15mm turn-ins (the area
which is folded over the boards and stuck down behind the
endpapers) — there shouldn’t be any readable text here however,
as it will be obscured by the edges of the boards and the
endpapers.

The 8mm grooves — either side of the spine — are where the book
hinges open, and also shouldn’t contain text. Some designs extend the spine background into
the grooves, making a feature of them, others extend the front/back background into them. The

example, left, does both — different back and front.
|

ARIS & PHILLIPS CLASSICAL TEXTS

THUCYDIDES

Again, the spine width

may vary slightly (see
previous pages), so a good
design will take this into
consideration both at the
spine and at the edges of

the board dimensions, where
backgrounds should extend
into the turn-ins so the normal
manufacturing fluctuations in
position are not apparent on
the final product. e ll[ i

1 YoogSH@FAAINH,L

ARIS & PHILLIPS CLASSICAL TEXTS

THUCYDIDES

sapoyy’(‘d

History
Book I

s an imprint of
OXBOW BOOKS

WITH AN INTRODUCTION, TRANSLATION & COMMENTARY BY

P.].Rhodes
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Brass (blocking) artwork

In order to add a silver, gold (or other basic colour) wording or design to a cloth case, it is necessary
to create a “brass” — a slab of metal with the design embossed, which is then used to stamp the
design into the case.

In order for us to do this, the artwork needs to be supplied as
black only. Simple line-art can be used that is not too intricate
and must also be black only at 1200dpi.

To convert images to black only using Photoshop: The
Gibraltar

1. Image Menu ->Image Size -> Resolution: 1200dpi; Law

Resample image (Bicubic smoother if possible); OK. Reports

2. Image menu -> Adjustments -> Threshold — adjust the
slider to best represent the image.

3. Image menu -> Mode -> Greyscale.
4. Image menu -> Mode -> Bitmap; Method: 50% T —— 1980_87
Threshold.

1980-87

e ———

The spine, front and back elements should be supplied
separately, and the size of the artwork should be as follows:

All Heights = Height of the trim size + 6mm Spine Width = As
obtained from us.

Front/Back Width = Width of trim size minus 4mm. Remember
trim size is the size of the internal book block.
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Spot UV artwork:

Matt laminated covers can have areas of gloss
varnish applied called a Spot UV. Artwork for this
should be supplied as black only in the areas that
require the varnish (see above for conversion of
images to black only). In order to get the exact
position of the varnish correct, it is advised that
the cover artwork is copied and amended by
changing objects to black that should have the
varnish applied, and anything else removed. The
example above is the PPC sample that has had
this treatment.

Plate sections

printondemand
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SAAIAADNH]T,

THUCYDIDES

This is where a book is to have a separate section or sections printed, perhaps in colour or on a
different (usually glossy) paper stock. Plate sections should be supplied in the same fashion as the
main text, but as a separate file or files, (remember to allow for bleeds).

Printed endpapers

The front endpapers can be printed on
pages 2, 3 and 4, and the back endpapers
on pages 1, 2, and 3. The side that cannot

be printed on is glued to the case. Pages 2
and 3 should be supplied as a spread, at the
height of the trim page size of your book and
twice its width. Pages 1 and 4 should have

a 4mm white mask down the bind edge to
allow for gluing onto the book block.

Front endp

/ Back endpaper Page 3

Back endpaper Page 2

Back Endpaper

Front Endpaper

Back endpaper Page 1

aper Page 2

Front endpaper Page 4

Front endpaper Page 3
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The Guide to Optimising Files

1. Open PDF file in Adobe Acrobat
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printondemand
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printondemand
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The Complete Global
Print & Publishing Solution

BookWIZARD
Online quote calculator for bespoke printing from
1 to 2,000 copies

wv
g
BookVAULT 5
No need for stock with printon-demand and auto- 2
stock replenishment a
3
o
(%]
BookGLOBAL a
Easy access fo UK & US retail & wholesale F|
markefs }
T EB) BookeLOBAL
2 a
BookSHOP L
We'll help you sell your baoks via &

thegreatbritishbookshop.co.uk p=] BookSHOP

Discover how we can meet your print needs
Call us on 01733 237867

www.printondemand-worldwide.com
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